Chapter 3: Amplitude Modulation

In modulation need two things:

1. a modulated signal: carrier signal: \( c(t) \)
2. a modulating signal: message signal: \( m(t) \)

carrier:

- \( c(t) = A_c \cos(2\pi f_c t); \) phase \( \phi_c = 0 \) is assumed.

message:

- \( m(t) \) (information-bearing signal)
- assume bandwidth/max freq of \( m(t) \) is \( W \)
Amplitude Modulation

Three types studied:

1. **Amplitude Modulation (AM)**
   (yes, it has the same name as the class of modulation techniques)

2. **Double Sideband-Suppressed Carrier (DSB-SC)**

3. **Single Sideband (SSB)**

Amplitude Modulation Techniques

**AM:**

For:

1. \(1 + k_2 m(t) > 0\) (envelope is always positive); and

2. \(f_c \gg W\) (message moves slowly compared to carrier)

\(m(t)\) can be recovered with an envelope detector.

\[
\begin{align*}
    s_{AM}(t) &= A_c [1 + k_2 m(t)] \cos(2\pi f_c t) \\
    S_{AM}(f) &= \frac{A_c^2}{2} [\delta(f - f_c) + \delta(f + f_c)] + \frac{k_2 A_c}{2} [M(f - f_c) + M(f + f_c)]
\end{align*}
\]

**DSB-SC:**

\[
\begin{align*}
    s_{DSB}(t) &= A_c \cos(2\pi f_c t) m(t) \\
    S_{DSB}(f) &= \frac{A_c}{2} [M(f - f_c) + M(f + f_c)]
\end{align*}
\]

- lower power
- \(B_T = 2W\)
- higher complexity
Amplitude Modulation Techniques

**DSB-SC:**

- An envelope detector will not be able to recover \( m(t) \); it will instead recover \(|m(t)|\).

- **Coherent demodulation** is required.

\[ c'(t) = A_c \cos(2\pi f_c t + \phi) \]

\[ s(t) \rightarrow \text{Product Modulator} \rightarrow \text{Low-pass filter} \rightarrow v_0(t) \rightarrow \text{Demodulated Signal} \]

\[ h(t) = 1/(\sqrt{t}) \]

Amplitude Modulation Techniques

**SSB:**

- **Coherent demodulation** works here as well.

\[ s_{USSB}(t) = \frac{A_c}{2} m(t) \cos(2\pi f_c t) - \frac{A_c}{2} \hat{m}(t) \sin(2\pi f_c t) \]

\[ S_{USSB}(f) = \begin{cases} \frac{A_c}{2} [M(f - f_c) + M(f + f_c)] & |f| \geq f_c \\ 0 & |f| < f_c \end{cases} \]

\[ s_{LSSB}(t) = \frac{A_c}{2} m(t) \cos(2\pi f_c t) + \frac{A_c}{2} \hat{m}(t) \sin(2\pi f_c t) \]

\[ S_{LSSB}(f) = \begin{cases} \frac{A_c}{2} [M(f - f_c) + M(f + f_c)] & |f| > f_c \\ 0 & |f| \leq f_c \end{cases} \]

\[ M(f) = -j \text{sgn}(f) \]

\[ h(t) = 1/|\sqrt{t}| \]

\[ v_0(t) \rightarrow \text{Product Modulator} \rightarrow \text{Low-pass filter} \rightarrow \text{Demodulated Signal} \]
### Costas Receiver

**Circuit for Phase Locking**: $\phi = 0$

**Message Signal $m_2(t)$**

\[ s(t) = A_c m_1(t) \cos(2\pi f_c t) + A_c m_2(t) \sin(2\pi f_c t) \]

**Quadrature Amplitude Modulation**

\[ s(t) = A_c m_1(t) \cos(2\pi f_c t) + A_c m_2(t) \sin(2\pi f_c t) \]

**Professor Deepa Kundur (University of Toronto) Final Exam Review 15 / 67**
Quadrature Amplitude Modulation

\[ s(t) = A_c m_1(t) \cos(2\pi f_c t) + A_c m_2(t) \sin(2\pi f_c t) \]

Chapter 4: Angle Modulation

Angle Modulation

- Phase Modulation (PM):
  \[ \theta_i(t) = 2\pi f_c t + k_p m(t) \]
  \[ f_i(t) = \frac{1}{2\pi} \frac{d\theta_i(t)}{dt} = 2\pi f_c k_p \frac{d m(t)}{dt} \]
  \[ s_{PM}(t) = A_c \cos[2\pi f_c t + k_p m(t)] \]

- Frequency Modulation (FM):
  \[ \theta_i(t) = 2\pi f_c t + 2\pi k_f \int_0^t m(\tau) d\tau \]
  \[ f_i(t) = \frac{1}{2\pi} \frac{d\theta_i(t)}{dt} = f_c + k_f m(t) \]
  \[ s_{FM}(t) = A_c \cos\left[2\pi f_c t + 2\pi k_f \int_0^t m(\tau) d\tau\right] \]
Angle Modulation

PM and FM:

\[ m(t) \xrightarrow{\text{Integrator}} \text{Phase Modulator} \xrightarrow{\theta(t) = A_c \cos(2\pi f_c t)} s_{\text{PM}}(t) \]

\[ m(t) \xrightarrow{\text{Differentiator}} \text{Frequency Modulator} \xrightarrow{\omega(t) = A_c \cos(2\pi f_c t)} s_{\text{FM}}(t) \]

Properties of Angle Modulation

1. Constancy of transmitted power
2. Nonlinearity of angle modulation
3. Irregularity of zero-crossings
4. Difficulty in visualizing message
5. Bandwidth versus noise trade-off

Narrowband FM

Suppose \( m(t) = A_m \cos(2\pi f_m t) \).

\[
\begin{align*}
    f_i(t) &= f_c + k_f A_m \cos(2\pi f_m t) = f_c + \Delta f \cos(2\pi f_m t) \\
    \Delta f &= k_f A_m \equiv \text{frequency deviation} \\
    \theta_i(t) &= 2\pi \int_0^t f_i(\tau) d\tau \\
    &= 2\pi f_c t + \frac{\Delta f}{f_m} \sin(2\pi f_m t) = 2\pi f_c t + \beta \sin(2\pi f_m t) \\
    \beta &= \frac{\Delta f}{f_m} \\
    s_{\text{FM}}(t) &= A_c \cos[2\pi f_c t + \beta \sin(2\pi f_m t)]
\end{align*}
\]

For narrow band FM, \( \beta \ll 1 \).

Narrowband FM

Modulation:

\[
s_{\text{FM}}(t) \approx A_c \cos(2\pi f_c t) - \beta A_c \sin(2\pi f_c t) + \sin(2\pi f_m t)
\]

DSB-SC signal

\[
\text{Modulating wave} \xrightarrow{\text{Integrator}} \text{Product Modulator} \xrightarrow{-90 \text{ degree Phase Shifter}} A_c \sin(2\pi f_c t)
\]

\[
A_c \cos(2\pi f_c t) -90 \text{ phase shift}
\]

\[
\text{Narrow-band FM wave}
\]

A_c \cos(2\pi f_c t)

-90 degree Phase Shifter

A_c \cos(2\pi f_c t)

carrier

-90° shift of carrier

\[
\frac{2\pi f_m}{f_m} \int_0^t m(\tau) d\tau
\]
Carson’s Rule

A significant component of the FM signal is within the following bandwidth:

\[ B_T \approx 2\Delta f + 2f_m = 2\Delta f \left( 1 + \frac{1}{\beta} \right) \]

- For \( \beta \gg 1 \), \( B_T \approx 2\Delta f = 2k_f A_m \)
- For \( \beta \ll 1 \), \( B_T \approx 2\Delta f \frac{1}{\beta} = \frac{2\Delta f}{\Delta f/f_m} = 2f_m \)

Generation of FM Waves: Armstrong Modulator

Demodulation of FM Waves

\[ s(t) \rightarrow \frac{d}{dt} s(t) \rightarrow \text{Ideal Envelope Detector} \rightarrow r(t) \]

Chapter 5: Pulse Modulation

- **Frequency Discriminator**: uses positive and negative slope circuits in place of a differentiator, which is hard to implement across a wide bandwidth
- **Phase Lock Loop**: tracks the angle of the incoming FM wave which allows tracking of the embedded message
Pulse Modulation

- The variation of a regularly spaced constant amplitude pulse stream to superimpose information contained in a message signal.

- Three types:
  1. Pulse Amplitude Modulation (PAM)
  2. Pulse Duration Modulation (PDM)
  3. Pulse Position Modulation (PPM)

Pulse Amplitude Modulation (PAM)

Pulse Duration Modulation (PDM)

Pulse Position Modulation (PPM)
Summary of Pulse Modulation

Let \( g(t) \) be the pulse shape.

▶ **PAM**:

\[
 s_{PAM}(t) = \sum_{n=-\infty}^{\infty} k_a m(nT_s) g(t - nT_s)
\]

where \( k_a \) is an amplitude sensitivity factor; \( k_a > 0 \).

▶ **PDM**:

\[
 s_{PDM}(t) = \sum_{n=-\infty}^{\infty} g\left( t - nT_s + M_d k_d m(nT_s) \right)
\]

where \( k_d \) is a duration sensitivity factor; \( k_d |m(t)|_{\text{max}} < M_d \).

▶ **PPM**:

\[
 s_{PPM}(t) = \sum_{n=-\infty}^{\infty} g(t - nT_s - k_p m(nT_s))
\]

where \( k_p \) is a position sensitivity factor; \( k_p |m(t)|_{\text{max}} < (T_s/2) \).

---

**PCM Transmitter**

- **Source**
- **Low-pass Filter**
- **Sampler**
- **Quantizer**
- **Encoder**

**PCM Transmitter: Sampler**

- **Source**
- **Low-pass Filter**
- **Sampler**
- **Quantizer**
- **Encoder**

---

**Pulse-Code Modulation**

▶ Most basic form of digital pulse modulation
**PCM Transmitter: Non-Uniform Quantizer**

- **Source** → **Low-pass Filter**
- **Low-pass Filter** → **Anti-aliasing Filter**
- **Anti-aliasing Filter** → **Sampler**
- **Sampler** → **Quantizer**
- **Quantizer** → **Digital signal**
- **Digital signal** → **Encoder**
- **Encoder** → **PCM Data Sequence**

**Diagram Description:**
- **Source** generates a **Continuous-time Message Signal**.
- **Low-pass Filter** removes high-frequency components.
- **Sampler** samples the signal above the Nyquist rate.
- **Quantizer** maps numbers to bit sequences using a Non-uniform Quantizer.
- **Amplitude Compressor** is also involved in the compression process.
- **Uniform Quantizer** is used for comparison.

**Graph:**
- A graph shows the relationship between **Normalized input** ($v$) and **Normalized output** ($m$). The graph is labeled with values from 0 to 3, indicating different quantization levels.

**Encoder: Example**

- **Source** → **Low-pass Filter**
- **Low-pass Filter** → **Anti-aliasing Filter**
- **Anti-aliasing Filter** → **Sampler**
- **Sampler** → **Quantizer**
- **Quantizer** → **Maps Numbers to Bit Sequences**
- **Maps Numbers to Bit Sequences** → **Encoder**

**Quantization-Level Index | Binary Codeword (R = 3)**

<table>
<thead>
<tr>
<th>Index</th>
<th>Codeword</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>000</td>
</tr>
<tr>
<td>1</td>
<td>001</td>
</tr>
<tr>
<td>2</td>
<td>010</td>
</tr>
<tr>
<td>3</td>
<td>011</td>
</tr>
<tr>
<td>4</td>
<td>100</td>
</tr>
<tr>
<td>5</td>
<td>101</td>
</tr>
<tr>
<td>6</td>
<td>110</td>
</tr>
<tr>
<td>7</td>
<td>111</td>
</tr>
</tbody>
</table>

**PCM: Transmission Path**

- **Source** → **Transmitter**
- **Transmitter** → **Transmission Path**
- **Transmission Path** → **Regenerative Repeaters**
- **Regenerative Repeaters** → **Received Wave**
- **Received Wave** → **Regenerated PCM Wave**
- **Regenerated PCM Wave** → **Decision-making Device**
- **Decision-making Device** → **Amplifier-Equalizer**
- **Amplifier-Equalizer** → **Timing Circuit**
- **Timing Circuit** → **Regenerated PCM Wave**

**Diagram Description:**
- **Source** inputs data to a **Transmitter**.
- The data is transmitted through a **Transmission Path** which includes **Regenerative Repeaters**.
- **Regenerated PCM Wave** is received and processed by a **Decision-making Device**.
- The **Decision-making Device** outputs data to an **Amplifier-Equalizer** which is then directed to a **Timing Circuit**.
**PCM: Regenerative Repeater**

Amplifier-Equalizer → Decision-making Device → Regenerated PCM Wave

**PCM: Receiver**

Two Stages:

1. **Decoding and Expanding:**
   1.1 regenerate the pulse one last time
   1.2 group into code words
   1.3 interpret as quantization level
   1.4 pass through expander (opposite of compressor)

2. **Reconstruction:**
   2.1 pass expander output through low-pass reconstruction filter (cutoff is equal to message bandwidth) to estimate original message $m(t)$

**Baseband Transmission of Digital Data**

Chapter 6: Baseband Data Transmission

**Binary Input**

- $b_k = \{0, 1\}$

**Transmit Filter $G(f)$**

- $s(t) = \sum_{k=-\infty}^{\infty} a_k g(t - kT_b)$

**Channel $H(f)$**

- $x(t) = s(t) \ast h(t)$

**Receive Filter $Q(f)$**

- $y(t) = x(t) \ast q(t) = s(t) \ast h(t) \ast q(t)$

- $y(t) = \sum_{k=-\infty}^{\infty} a_k g(t - kT_b) \ast h(t) \ast q(t) = \sum_{k=-\infty}^{\infty} a_k p(t - kT_b)$
Baseband Transmission of Digital Data

\[
y(t) = \sum_{k=-\infty}^{\infty} a_k p(t - kT_b)
\]

where \( p(t) = g(t) \ast h(t) \ast q(t) \)

\[
P(f) = G(f) H(f) Q(f).
\]

The Nyquist Channel

- **Minimum bandwidth channel**

- **Optimum pulse shape:**
  \[
  p_{\text{opt}}(t) = \sqrt{E} \text{sinc}(2B_0 t)
  \]
  \[
  P_{\text{opt}}(f) = \begin{cases} \sqrt{E} & -B_0 < f < B_0 \smallskip \0 & \text{otherwise} \end{cases}, \quad B_0 = \frac{1}{2T_b}
  \]

**Note:** No ISI.

\[
p_i = p(iT_b) = \sqrt{E} \text{sinc}(2B_0 iT_b) \sqrt{E} \text{sinc} \left( 2 \cdot \frac{1}{2T_b} iT_b \right) = \sqrt{E} \text{sinc}(i) = 0.
\]

**Disadvantages:** (1) physically unrealizable (sharp transition in freq domain); (2) slow rate of decay leaving no margin of error for sampling times.

To avoid intersymbol interference (ISI), we need \( p_i = 0 \) for \( i \neq 0 \).
Raised-Cosine Pulse Spectrum

- has a more graceful transition in the frequency domain
- more practical pulse shape:

\[
p(t) = \sqrt{E} \text{sinc}(2B_0 t) \left( \frac{\cos(2\pi \alpha B_0 t)}{1 - 16\alpha^2 B_0^2 t^2} \right)
\]

\[
P(f) = \begin{cases} 
\frac{\sqrt{E}}{2B_0} & 0 \leq |f| < f_1 \\
\frac{\sqrt{E}}{4B_0} \left( 1 + \cos \left[ \pi \left( \frac{|f|}{B_0} - f_1 \right) \right] \right) & f_1 < f < 2B_0 - f_1 \\
0 & 2B_0 - f_1 \leq |f|
\end{cases}
\]

\[
\alpha = 1 - \frac{f_1}{B_0}
\]

\[
B_T = B_0(1 + \alpha) \quad \text{where} \quad B_0 = \frac{1}{2T_b} \quad \text{and} \quad f_v = \alpha B_0
\]

Note: No ISI. \( p_i = 0 \).

The Eye Pattern

- Slope dictates sensitivity to timing error
- Best sampling time
- Distortion at sampling time
- Time interval over which wave is best sampled.

Chapter 7: Digital Band-Pass Modulation Techniques
Binary Modulation Schemes

\[ c(t) = A_c \cos(2\pi f_c t + \phi_c) \]

- **Binary amplitude-shift keying (BASK):** carrier amplitude is keyed between two possible values (typically \( \sqrt{E_b} \) and 0 to represent 1 and 0, respectively); carrier phase and frequency are held constant.

- **Binary phase-shift keying (BPSK):** carrier phase is keyed between two possible values (typically 0 and \( \pi \) to represent 1 and 0, respectively); carrier amplitude and frequency are held constant.

- **Binary frequency-shift keying (BFSK):** carrier frequency is keyed between two possible values (typically \( f_1 \) and \( f_2 \) to represent 1 and 0, respectively); carrier amplitude and phase are held constant.

Preliminaries

\[ c(t) = A_c \cos(2\pi f_c t + \phi_c) \]

- \( T_b \) represents the bit duration
- \( E_b \) represents the energy of the transmitted signal per bit
- In digital communications the carrier amplitude is normalized to have unit energy in one bit duration; thus we set
  \[ A_c = \sqrt{\frac{2}{T_b}} \]
- The carrier frequency \( f_c = \frac{k}{T_b} \) for \( k \in \mathbb{Z} \) to ensure an integer number of carrier cycles in a bit duration.

Carrier for Digital Communications

Therefore

\[ c(t) = \sqrt{\frac{2}{T_b}} \cos(2\pi f_c t + \phi_c). \]

For \( k = 4 \)

Binary Amplitude-Shift Keying (BASK)

Let \( \phi_c = 0 \) and the carrier frequency is \( f_c \).

\[ b(t) = \begin{cases} \sqrt{E_b} & \text{for binary symbol 1} \\ 0 & \text{for binary symbol 0} \end{cases} \]

\[ c(t) = \sqrt{\frac{2}{T_b}} \cos(2\pi f_c t + \phi_c) = \sqrt{\frac{2}{T_b}} \cos(2\pi f_c t) \]

\[ s(t) = b(t) \cdot c(t) = \begin{cases} \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_c t) & \text{for symbol 1} \\ 0 & \text{for symbol 0} \end{cases} \]
**BASK Transmitter and Receiver**

**Transmitter**

\[ \{ b_k \} \xrightarrow{\text{Binary input sequence}} \{ b(t) \} \xrightarrow{\text{Level Encoding}} b(t) \xrightarrow{\text{Product Modulator}} c(t) = \sqrt{\frac{2}{T_b}} \cos(2\pi f_c t) \xrightarrow{\text{Carrier}} s(t) = b(t)c(t) \]

**Receiver**

\[ s(t) \xrightarrow{\text{BASK wave}} \hat{b}(t) \xrightarrow{\text{Envelope Detector}} \hat{b}(i T_b) \xrightarrow{\text{Decision-Making Device}} \{ \hat{b}_i \} \]

---

**BPSK Transmitter and Receiver**

**Transmitter**

\[ \{ b_k \} \xrightarrow{\text{Binary input sequence}} \{ b(t) \} \xrightarrow{\text{Level Encoding}} b(t) \xrightarrow{\text{Product Modulator}} c(t) = \sqrt{\frac{2}{T_b}} \cos(2\pi f_c t) \xrightarrow{\text{Carrier}} s(t) = b(t)c(t) \]

**Receiver**

\[ s(t) \xrightarrow{\text{Low-pass Filter}} \hat{b}(t) \xrightarrow{\text{Threshold}} \hat{b}(i T_b) \xrightarrow{\text{Decision-Making Device}} \{ \hat{b}_i \} \]

---

**Binary Phase-Shift Keying (BPSK)**

\[ s_i(t) = \begin{cases} 
\sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_c t) & \text{for symbol 1} \ (i = 1) \\
\sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_c t + \pi) & \text{for symbol 0} \ (i = 2) 
\end{cases} \]

---

**Binary Frequency-Shift Keying (BFSK)**

Let \( \phi_c = 0, |f_1 - f_2| = \frac{1}{T_b} \) and \( f_i = \frac{k_i}{T_b} \) (integer number of cycles in a bit duration).

\[ s(t) = \begin{cases} 
\sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_1 t) & \text{for symbol 1} \ (i = 1) \\
\sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_2 t) & \text{for symbol 0} \ (i = 2) 
\end{cases} \]
BFSK Transmitter and Receiver

Transmitter

Binary input sequence \( \{b_k\} \)

\[ s(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f c t) \]

\( s(t) \) BFSK Transmitted Signal

Receiver

Envelope Detector

\( t = \frac{sT_b}{f_1} \)

\( v_1 = \begin{cases} 1 & \text{if } v_1 > v_2 \\ 0 & \text{if } v_2 > v_1 \end{cases} \)

Envelope Detector

\( t = \frac{sT_b}{f_2} \)

Comparator

\[ s_1(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_1 t) \quad \text{for symbol 1} \]

\[ s_2(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_2 t) \quad \text{for symbol 0} \]

Summary

BASk

\[ s_1(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f c t) \quad \text{for symbol 1} \]

\[ s_2(t) = 0 \quad \text{for symbol 0} \]

BPSK

\[ s_1(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_1 t + 0) \quad \text{for symbol 1} \]

\[ s_2(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_2 t + \pi) \quad \text{for symbol 0} \]

BFSK

\[ s_1(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_1 t) \quad \text{for symbol 1} \]

\[ s_2(t) = \sqrt{\frac{2E_b}{T_b}} \cos(2\pi f_2 t) \quad \text{for symbol 0} \]

Summary: Phasor Diagrams

BASk

<table>
<thead>
<tr>
<th>symbol</th>
<th>0</th>
<th>symbol</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td></td>
</tr>
</tbody>
</table>

BPSK (antipodal)

<table>
<thead>
<tr>
<th>symbol</th>
<th>0</th>
<th>symbol</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td></td>
</tr>
</tbody>
</table>

BFSK (orthogonal)

<table>
<thead>
<tr>
<th>symbol</th>
<th>0</th>
<th>symbol</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td>( \sqrt{\frac{2E_b}{T_b}} )</td>
<td></td>
</tr>
</tbody>
</table>
**M-ary Digital Modulation Schemes**

For $M = 2^m$ and $T = mT_b$.

- **M-ary Phase-Shift Keying**
  \[ s_i(t) = \sqrt{\frac{2E}{T}} \cos\left(2\pi f_c t + \frac{2\pi i}{M}\right) \]
  \[ i = 0, 1, \ldots, M - 1, 0 \leq t \leq T. \]

- **M-ary Quadrature Amplitude Modulation**
  \[ s_i(t) = \sqrt{\frac{2E_0}{T}} a_i \cos(2\pi f_c t) - \sqrt{\frac{2E_0}{T}} b_i \sin(2\pi f_c t) \]
  \[ i = 0, 1, \ldots, M - 1, 0 \leq t \leq T. \]

- **M-ary Frequency-Shift Keying**
  \[ s_i(t) = \sqrt{\frac{2E}{T}} \cos\left(\frac{\pi}{T} (n + i) t\right) \]
  \[ i = 0, 1, \ldots, M - 1, 0 \leq t \leq T. \]

---

**Important Identities**

\[
\begin{align*}
\cos(A + B) &= \cos(A) \cos(B) - \sin(A) \sin(B) \\
\cos(A) \cos(B) &= \frac{1}{2} \cos(A + B) + \frac{1}{2} \cos(A - B) \\
\cos(A) \sin(B) &= \frac{1}{2} \sin(A + B) - \frac{1}{2} \sin(A - B) \\
\cos(A) &= \sin\left(A + \frac{\pi}{2}\right) \quad \cos(A + \pi) = -\cos(A) \\
\cos(A) &= \cos(-A) \quad \sin(A) = -\sin(-A) \\
\cos^2(A) &= \frac{1}{2} + \frac{1}{2} \cos(2A) \\
\cos^2(A) + \sin^2(A) &= 1 \\
\cos(A) &\approx 1 \quad \text{for } |A| \ll 1 \\
\sin(A) &\approx A \quad \text{for } |A| \ll 1
\end{align*}
\]